The owner friendly® phone system for small business

VoIP Network Configuration Guide

Release 7.10

talkswitch®
a division of FORTINET.
# TABLE OF CONTENTS

INTRODUCTION ............................................................................................................. 1

  About this guide ...................................................................................................... 1
  Where to go for further information .................................................................... 1
  Documentation ....................................................................................................... 1
  Contacting Technical Support ................................................................................ 1

CONNECTING TO A NETWORK .................................................................................. 2

  Connecting to local and IP networks .................................................................... 2
  Confirming network capacity ................................................................................ 2

CONFIGURING IP ADDRESSES .................................................................................. 3

  Setting the system IP settings ............................................................................... 3
  Setting the public IP address ................................................................................. 4

CONFIGURING THE ROUTER ...................................................................................... 6

  Configuring the router manually ......................................................................... 8

EXTERNAL IP EXTENSIONS ............................................................................................ 9

MULTI-BRANCH VOIP NETWORK .................................................................................. 11

SETTING UP A MULTI-BRANCH PROFILE FOR THE SIP SERVER ......................... 12

SETTING UP A MULTI-BRANCH PROFILE FOR A SIP CLIENT .................................. 13

CONFIGURING VOIP NUMBERS FOR A MULTI-BRANCH VOIP NETWORK ............ 14

SETTING UP LINE HUNT GROUPS ............................................................................. 15

ADVANCED VOIP CONFIGURATION .......................................................................... 15

VERIFYING THE MULTI-BRANCH VOIP NETWORK .................................................... 16

SERVICE PROVIDER VOIP NETWORK ....................................................................... 17
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SETTING UP A SERVICE PROVIDER PROFILE</td>
<td>18</td>
</tr>
<tr>
<td>Activate profile</td>
<td>18</td>
</tr>
<tr>
<td>Automatic configuration</td>
<td>18</td>
</tr>
<tr>
<td>Manual configuration</td>
<td>19</td>
</tr>
<tr>
<td>Provisioning details</td>
<td>20</td>
</tr>
<tr>
<td>SETTING CODEC OPTIONS</td>
<td>21</td>
</tr>
<tr>
<td>CONFIGURING VOIP NUMBERS FOR A SERVICE PROVIDER VOIP NETWORK</td>
<td>22</td>
</tr>
<tr>
<td>SETTING UP LINE HUNT GROUPS</td>
<td>23</td>
</tr>
<tr>
<td>ADVANCED VOIP CONFIGURATION</td>
<td>24</td>
</tr>
<tr>
<td>Setting up caller ID</td>
<td>24</td>
</tr>
<tr>
<td>Reserving VoIP lines</td>
<td>25</td>
</tr>
<tr>
<td>VERIFYING REGISTRATION</td>
<td>26</td>
</tr>
<tr>
<td>APPENDIX A — MULTI-BRANCH VOIP NETWORK ADMINISTRATION FORM</td>
<td>27</td>
</tr>
</tbody>
</table>
INTRODUCTION

About this guide

This guide will help you plan and configure your phone system to use VoIP (Voice over IP) in order to:

- Use external IP extensions.
- Connect multiple branches.
- Subscribe to a VoIP service provider.

Where to go for further information

You can find additional documentation:

- Within the Management software by clicking the Help icons.
- By choosing Start > Programs > TalkSwitch 7.10 > TalkSwitch Configuration 7.10 > Documentation once the software is installed.
- On the Management Software CD.
- In the support section at http://global.talkswitch.com

Documentation

In addition to this guide, the following documentation is available:

- VoIP service provider configuration guides.
- The TalkSwitch Start Guide shows how to install and set up a system.
- The TalkSwitch User Guide provides complete information about the system.

Contacting Technical Support

We trust your phone system will provide exceptional features, performance and value to your business. Should you have any further questions:

- Contact your authorized TalkSwitch reseller.
- If you purchased directly from TalkSwitch, e-mail support@talkswitch.com, providing your company name and TalkSwitch production information.
CONNECTING TO A NETWORK

Each location requires a high-speed connection to the Internet or private IP network that is sufficient for VoIP calls.

Connecting to local and IP networks

Set up a LAN (local area network) with an Ethernet switch, router, and modem or gateway. The Ethernet switch can be integrated into the router. Connect a computer to the LAN for configuring the phone system and other equipment. Use the provided RJ-45 Ethernet cable to connect the phone system to the LAN. To ensure reliability, all equipment should be connected to a UPS (uninterrupted power supply).

![Network Diagram]

Figure 1: Local and IP network setup

Confirming network capacity

Ensure the LAN in each location has a reliable high-speed broadband connection to the Internet or private IP network. The quality of VoIP calls, especially on mixed voice and data networks, depends on high data-transfer rates across the network. The limiting factor is the upstream bandwidth to the ISP (Internet Service Provider). ‘Lite’ broadband connections (128 Kbps or less) are not suitable for simultaneous voice and data traffic.

To test the VoIP call capacity based on your Internet connection speed, perform the test found in the support section at [http://global.talkswitch.com](http://global.talkswitch.com).
CONFIGURING IP ADDRESSES

Setting the system IP settings

Each unit must be configured with a local IP address. These addresses are used to direct VoIP calls to the appropriate location.

1. In the Management Software, select the IP Configuration page. By default, Obtain IP and DNS information automatically is selected and the area shows IP addresses from the router.

2. Change Obtain IP and DNS information automatically to Use configured IP and DNS information in order to lock in the IP addresses.

3. In some cases, the System IP Settings area may be blank because your router has not delivered the IP addresses. If so, enter the following IP addresses from your LAN administrator:
   a) Enter a static IP address for each unit in the Unit IP address boxes.
   b) Enter the Subnet mask for the LAN. This address determines the subnet that the unit IP addresses belong to.
   c) Enter the IP address of the Default gateway on your network. A gateway is a hardware device that connects the office network to the Internet. The router may act as default gateway.
   d) Enter the IP address of the Preferred DNS server. DNS is a service that is used to resolve a domain name to an IP address. The router may act as DNS server.
   e) If applicable, enter the IP address of the Alternate DNS server.
Setting the public IP address

If you are setting up an external IP extension, or the SIP server of a multi-branch VoIP network, you must configure a public IP address for the system. Some service provider VoIP networks also require the system to have a public IP address.

1. Set the **Type of public address**. Choices are:
   - **Dynamic public IP address** — This is the default setting. Your ISP (Internet Service Provider) will assign different public IP addresses to your location. The system will check its public IP address every few minutes. When the public IP address changes, the system will automatically use the new one, in order to manage VoIP calls properly.
   - **Static public IP address** — A static IP address is fixed. Your Internet Service Provider assigns the static IP address. If this location will have the SIP server for a multi-branch VoIP network, we recommend using a static IP address.

If **Static public IP address** is selected, the window allows you to enter the **Current public IP address**.
2. If you selected *Dynamic public IP address*, enter the *Public domain name*. Get the public domain name from your ISP.

A DDNS (Dynamic Domain Name Service) provider such as [www.dyndns.com](http://www.dyndns.com) matches your dynamic IP addresses to your public domain name, so your multi-branch VoIP network or external IP phones will continue to work when the IP address changes.

If your router supports DDNS, ensure it supports your DDNS provider, and configure it to update the DNS servers.

If your router does not support DDNS, download one of the applications specified on [www.dyndns.com](http://www.dyndns.com). To update the DNS servers, the application needs to run on a PC connected to the same LAN as the phone system.

3. If you selected *Static public IP address*, enter the *Current public IP address* from your Internet Service Provider. Leave the *Public domain name* box blank.

If the phone system is not behind a router, or if a private virtual network is used, the public IP address is the local IP address of the unit acting as local proxy.

Note that it will take up to one minute for the new static public IP address to take effect.

4. Record the *Current public IP address* or the *Public domain name*.

If you are setting up an external IP extension, you will need the public IP address or public domain name of the system.

If you are setting up a multi-branch VoIP network, the multi-branch profiles of the SIP clients must be configured with the public IP address or public domain name of the SIP server.
CONFIGURING THE ROUTER

The Router Port Forwarding area of the IP Configuration page displays the type of gateway device (i.e. the type of router), the IP address of the gateway (i.e. router), and whether router configuration is required.

A router is a gateway between the local area network and the Internet. Most routers have a firewall to block unwanted data from the Internet. For voice data to reach the phone system through the firewall, port forwarding is required.

If you are setting up external IP extensions, a multi-branch VoIP network, or a VoIP service that doesn’t handle port forwarding, port forwarding is required.

If port forwarding is required, and your router supports uPNP (Universal Plug and Play), ensure uPNP is enabled. The system will use uPNP to automatically set up port forwarding, and the Automatic (uPNP Enabled) link will appear. No router configuration is required.

If port forwarding is required but your router doesn’t support uPNP, or automatic port forwarding doesn’t work, the Manual port mapping required link will appear. You will need to configure the router as described below.

1. Select the IP Configuration page.
2. If required, click the Manual port mapping required link. The Manual Port Mapping window appears. It lists the packet type, port number, IP address and protocol of each required port.

![Manual Port Mapping Window](image-url)
3. To access the router configuration:
   a) Click the link containing the IP address of the gateway. The default browser starts, and prompts you for the router's user name and password.
   b) Enter the router's user name and password. The browser shows a setup screen.
   c) Navigate to the screen used to set up port forwarding. See your router documentation.
   d) Set up port forwarding using the information from the **Manual Port Mapping** window. See your router documentation for instructions on how to map ports.

4. To check the status of each port through the firewall, click **Check Firewall**. The **Firewall Test** window appears.

![Firewall Test Window](image)

5. Select the services you want to check.

6. Click **Test Ports**. The system will check the ports for the selected services.
Configuring the router manually

If you cannot access the router configuration through the IP Configuration page, configure the router manually.

1. Open the router configuration and navigate to the screen used to set up port forwarding. See your router documentation.

2. In the Management software on the IP Configuration page, click the Manual Port Mapping Required link.

3. Map the port indicated for SIP (VoIP) signaling.

   If required, you can map a different port. Select Troubleshooting > VoIP and enter the port in the SIP signalling port field.

   Map the rest of the ports to the IP addresses indicated in the Manual Port Mapping window.

![Manual Port Mapping](image)

   If required, you can map different ports. Select Troubleshooting > VoIP.

4. Map ports 9393, 8485 and 8486 (Type: TCP) to the unit acting as local proxy to allow remote configuration of the system.

5. If available, enable Quality of Service (QoS) to give voice traffic priority over data.

6. Save the configuration to the router.
EXTERNAL IP EXTENSIONS

**Warning!** Calls to an emergency service number from an external IP extension will not send the correct address to the emergency operator. We strongly recommend that you apply a warning label to any external IP extension stating:

**If an emergency call is made from this phone, you must provide your address to the emergency operator.**

An external IP extension is an IP phone located outside the office. It is configured as a local extension of a system, but connects over the Internet or private data network. A user can receive or place a call with their external IP extension through the phone system to the standard telephone network or to a VoIP network.

For example, the following illustration shows external IP extension 151 at a home office, and 152 at a branch office. The external IP extensions connect to the phone system at the main office over the Internet. In this example, a user can receive or place a call with their external IP extension through the phone system to the standard telephone network.

![External IP extensions diagram](image)

**Figure 2: External IP extensions**

Before proceeding, ensure you have:

- Connected the system at each location to a network (see page 2).
- Configured local and public IP addresses (page 3).
- Configured the router (page 6).
To set up an external IP extension:

1. Add the external IP extension, as described in *Adding IP Phones* in Chapter 2 of the *TalkSwitch User Guide*.

2. Verify operation of the external IP extension:
   a) Select the **Local Extension/Fax** page.
   b) Select the external IP extension.
   c) Confirm *Extension status* is *Registered*, and the phone’s *IP address* appears in the *IP Extension Details* area.

3. Optionally, set the *Time zone* of the extension.

4. Optionally, perform advanced VoIP configuration:
   a) All VoIP lines are shared by default. You can reserve VoIP lines for the external IP extensions. See *Reserving VoIP lines* on page 25.
   b) External IP extensions use G.711µ as their preferred codec. This can be changed under *Troubleshooting > Extensions > IP Extensions*. 
MULTI-BRANCH VOIP NETWORK

A multi-branch VoIP network has at least one SIP device at each location. A SIP device is a VoIP-enabled phone system, IP telephone or SIP gateway. One phone system in the network acts as the SIP server. The other SIP devices are SIP clients.

A user, auto attendant or call cascade can dial a VoIP number to reach an extension, auto attendant or voice mailbox at any location.

For example, the following illustration shows a multi-branch VoIP network with two locations. Calls between the offices are routed over the Internet, and local calls are routed over the traditional telephone network.

![Multi-branch VoIP network diagram]

Figure 3: Multi-branch VoIP network

Five VoIP numbers are assigned to San Francisco (351 to 355), and nine are assigned to New York (361 to 369). These VoIP numbers can be dialed directly from any extension, auto attendant or call cascade in the network.

The phone system in the San Francisco office has a static public IP address, so is designated as the SIP server. The phone system in New York is a SIP client.

VoIP location numbers should have the number of digits specified in your numbering plan for maximum functionality (3, 4 or 5 digits). All units in the VoIP network should have the same dialing plan.

Before proceeding, ensure you have:
- Connected the system at each location to a network (see page 2).
- Configured local and public IP addresses (page 3).
- Configured the router (page 6).
SETTING UP A MULTI-BRANCH PROFILE FOR THE SIP SERVER

The multi-branch profile for the SIP server shows registration details and contains authentication information.

1. Connect to the system that will act as the SIP server.

2. Select the **VoIP Configuration** page.

3. Select **Profile MB**, which is for configuring the multi-branch profile.

4. Set the starting number for VoIP numbers range. A range of 50 numbers is reserved for VoIP numbers in the system. The range will begin with the number you put here.

5. Leave the **Disable public IP address substitution** checkbox cleared.

6. Select the **This location is the Proxy/Registrar** checkbox.

7. Set **Registrar authentication** to **Yes**. This restricts access and allows only authorized devices to connect.

8. Enter a **User/account** name. All SIP clients must use this name.

9. Enter a **Password**. All SIP clients must use this password.

10. Ensure your router is set up to perform port forwarding for the SIP Signalling and RTP ports. See **Configuring the router** on page 6.
SETTING UP A MULTI-BRANCH PROFILE FOR A SIP CLIENT

The multi-branch profile for a SIP client contains registration details and authentication information.

1. Connect to a system that will be a SIP client.
2. Select the VoIP Configuration page.
3. Select Profile MB, which is for configuring the multi-branch profile.

4. Leave the Disable public IP address substitution checkbox cleared.
5. Leave the This location is the Proxy/Registrar checkbox cleared.
6. Enter the Current public IP address or Public domain name of the SIP server into the Proxy/Registrar server name box.

   If the SIP server is using a non-default SIP signalling port (i.e. if the SIP server is not using 5060 as the SIP signalling port), specify the port number after a colon at the end of the public IP address or public domain name (e.g. 123.45.67.89:3456).

7. Enter the User/account name from the SIP server. All SIP clients must use this name.
8. Enter the Password from the SIP server. All SIP clients must use this password.
9. Ensure your router is set up to perform port forwarding for the SIP Signalling and RTP ports. See Configuring the router on page 6.
CONFIGURING VOIP NUMBERS FOR A MULTI-BRANCH VOIP NETWORK

A VoIP location number is like a telephone number, and is used to dial a system at a particular location. Each VoIP location number must be unique (i.e. only used at one location).

VoIP location numbers can be dialed from any extension, auto attendant or call cascade to any extension, auto attendant or voice mailbox in the multi-branch VoIP network. No hunt group number is required.

To assist in assigning VoIP location numbers for your network, use the Appendix A — Multi-branch VoIP network administration form on page 27.

1. Select the VoIP Numbers page.

2. Select a VoIP number slot.

3. Select the Activate VoIP Number checkbox.

4. Set the VoIP profile to multi-branch.

5. Enter the VoIP location number into the VoIP location number box. The VoIP location number box shows the range of reserved VoIP location numbers. Your VoIP location numbers should have the same number of digits as the other numbers in your dialing plan for full functionality. You can change the starting point of the range on the VoIP Configuration page.

6. Set up call handling for the VoIP number. For more information, click the Help icon in the Call Handling area.

7. Repeat steps 2 to 6 for each additional VoIP number.
SETTING UP LINE HUNT GROUPS

Warning! Assign hunt group 9 or 0 to the group of telephone lines or VoIP trunks used for calls to emergency services. Failure to properly configure hunt groups could prevent emergency calls.

If a VoIP-enabled unit is present, hunt group 88 uses the multi-branch VoIP network by default, and the other hunt groups use telephone lines. You can modify these default settings as described on page 23.

Note that the user does not have to dial the hunt group number before VoIP numbers: these automatically use the multi-branch VoIP network.

If 50 VoIP numbers aren’t enough for the network, you can set up longer VoIP numbers. To reach a longer VoIP number, the user will first dial a hunt group number.

A local extension can be restricted to a set of hunt groups in order to control access to VoIP networks. See Hunt group permissions in Chapter 2 of the TalkSwitch User Guide.

ADVANCED VOIP CONFIGURATION

Optionally, perform advanced VoIP configuration.

1. The default preferred codec is G.729. You can select the Preferred codec for the multi-branch profile. All locations must support the same codec. See Setting codec options on page 21.

2. VoIP calls use extension names for caller ID by default. You can set the source for VoIP caller ID at each location. The same setting will be used by the multi-branch profile and all service provider profiles. See Setting up caller ID on page 24.

3. All VoIP lines are shared by default. You can reserve VoIP lines for the multi-branch profile at each location. See Reserving VoIP lines on page 25.

4. To transfer settings from your computer to the system, choose File > Save. A window appears indicating the configuration is being sent.
VERIFYING THE MULTI-BRANCH VOIP NETWORK

If you are configuring the multi-branch profile for the SIP server, the window enables the View Registrar Entries button. Clicking the button shows the Registrar Entries window with a list of VoIP numbers, their IP addresses and port numbers, and the number of seconds until their registrations with the SIP server will expire.

1. Select the VoIP Configuration page.

2. Select Profile MB, and then click View Registrar Entries. The Registrar Entries window appears.
SERVICE PROVIDER VOIP NETWORK

Using a service provider VoIP network requires at least one VoIP-enabled phone system. The service provider acts as the SIP server. The service provider assigns the VoIP numbers and VoIP configuration parameters.

For example, the following illustration shows a service provider VoIP network.

To reach an outside party, the user dials the hunt group number associated with the service provider profile, and then dials the phone number.

To reach a local extension, an outside party dials the VoIP number that was assigned to the system by the service provider.

Before proceeding, ensure you have:
- Connected the system at each location to a network (see page 2).
- Configured local IP addresses (page 3), and public IP addresses if required.
- Configured the router (page 6).
SETTING UP A SERVICE PROVIDER PROFILE

A service provider profile contains the settings that allow your phone system to register with the provider.

If you are using an approved VoIP service provider, visit the support website at http://global.talkswitch.com to access the service configuration guide for your VoIP service provider.

1. Select the **VoIP Configuration** page.
2. Select a **Profile** (SP 1 to SP 4).

Activate profile

You can set up a service provider profile automatically or manually.

Automatic configuration

1. Select the **Activate Profile** checkbox.
2. The **Service Provider** menu offers a list of approved VoIP service providers. If your service provider appears in the menu, click on the name. The name is then displayed in the **Service Provider** field.
3. Click the **Update configuration** button. The essential settings for communication with the service provider’s registration server will be completed automatically.

4. If you want to customize other aspects of your VoIP lines, you may do so in the **System VoIP Options** area. See **System VoIP options** in Chapter 2 of the *TalkSwitch User Guide*.

Account-specific and number-specific settings are not automatically configured. These must be entered on the **VoIP Numbers** page.

**Manual configuration**

1. Select the **Activate Profile** checkbox.

2. Enter the **Profile name**. The default profile name is **Service provider n** (e.g. **Service provider 1**).

3. If your service provider requires you to register using your private IP address, select the **Disable public IP address substitution** checkbox. Check with your service provider.

4. Some providers require the system to register using the user name or account information rather than the VoIP number(s) provided. If so, check the **Register with authentication username** box to have the system register with the user name information provided in the **VoIP numbers** page. Check with your VoIP service provider if you’re uncertain which method of registration is required.
5. If your service provider requires keep alive messages, and if your router does not support uPnP, check the *Enable NAT keep alives* checkbox.

   a) Click **Settings**. The **Keep Alive Settings** window appears.

```
Keep Alive Settings

Select the method used to keep ports open: [Simple ping]
Specify the ping frequency (in seconds): [45]

OK    Cancel
```

b) Select the method used to keep ports open. Choices are:
   - *Simple ping* — A standard ping message that works with all SIP servers.
   - *Nortel ping* — A ping message that works with Nortel SIP servers (e.g. Nortel MCS 5200).

   c) If necessary, change the ping frequency. The default setting is 45 seconds.

6. You can specify which codecs to use by clicking the **Codec options** button. See *Setting codec options* on page 21.

Provisioning details

Enter the IP addresses or public domain names, as provided by the service provider, into the following boxes. If the service provider does not specify a value, leave the box blank.

- *Proxy server name*
- *Registrar server name*
- *Outbound proxy*
- *Realm/domain*

The **View All Registration** button will allow you to confirm connection to your service provider once you have completed the configuration of your VoIP numbers.

If you want to customize other aspects of your VoIP lines, you may do so in the **System VoIP Options** area. See *System VoIP options* in Chapter 2 of the TalkSwitch User Guide.
SETTING CODEC OPTIONS

If you are using an approved VoIP service provider, visit the support website at http://global.talkswitch.com to access the service configuration guide for your VoIP service provider. The service configuration guide lists supported codecs.

A codec is a method of compressing and decompressing audio signals for communication across a network. The system supports the G.729 and G.711 (µ-law or A-law) codecs for VoIP calls. If your service provider or equipment requires specific codecs for VoIP or Fax over IP calls, you can restrict the system to use the required codec.

The Codec Options window allows you to select the codecs that your system can use, specify the preferred codec, and clear the unsupported codecs. You can specify the codecs for the multi-branch profile, and for each service provider profile. External IP extensions will use the preferred codec specified in the multi-branch profile.

1. Select the VoIP Configuration page.
2. Click Codec Options. The Codec Options window appears.

![Codec Options Window]

3. Select the codecs that your system can use, and clear the unsupported codecs. The following codecs are supported:
   - **G.729** — This codec provides good quality. It requires the least bandwidth and accommodates the highest number of concurrent calls.
   - **G.711µ** — This codec provides high quality and supports Fax over IP. It requires the most bandwidth and accommodates the fewest number of concurrent calls. G.711µ is used in North America and Japan.
   - **G.711A** — This codec provides high quality and supports Fax over IP. It requires the most bandwidth and accommodates the fewest number of concurrent calls. G.711A is used worldwide except for North America and Japan.
4. Select the Preferred codec. G.729 is the default codec, which uses the least bandwidth and accommodates the highest number of concurrent calls.
5. Set Voice activity detection (VAD). Enabling VAD reduces voice bandwidth when no speech is detected, and reduces transmission of background noise. We recommend disabling VAD to keep bandwidth available for speech.
CONFIGURING VOIP NUMBERS FOR A SERVICE PROVIDER VOIP NETWORK

If you are using a TalkSwitch-certified VoIP service provider, visit the support website at http://global.talkswitch.com to access the service configuration guide for your VoIP service provider. Otherwise, use the procedures in this section.

Your service provider will assign you VoIP numbers.

1. Select the **VoIP Numbers** page.

2. Select a VoIP number slot.

3. Select the **Activate VoIP Number** checkbox.

4. Set the VoIP profile to the service provider (e.g. **My Service Provider**).

5. Enter the **Country Code** (if required), the **City or Area Code** and the **Number**.

6. Enter the **User/account** and the **Password** (if required) for this number.

7. Set up call handling for the VoIP number. For more information, click the **Help** icon in the **Call Handling** area.

8. Repeat steps 2 to 7 for each additional VoIP number.
SETTING UP LINE HUNT GROUPS

**Caution!** Ensure that hunt group 9 or 0 is assigned to the group of telephone lines or VoIP trunks used for calls to emergency services. Failure to properly configure hunt groups could prevent emergency calls.

A hunt group is a set of lines that are available for making an outbound call. It can use selected telephone lines, all VoIP lines associated with the multi-branch VoIP network, or all VoIP lines associated with a service provider VoIP network.

The configuration has nine different hunt groups. If a VoIP-enabled unit is present, hunt group 88 uses the multi-branch VoIP network by default, and the other hunt groups use telephone lines. You can modify these default settings as required. If you are using multiple service provider VoIP networks, set up a hunt group for each service provider.

A local extension can be restricted to a set of hunt groups in order to control access to VoIP networks. See *Hunt group permissions* in Chapter 2 of the *TalkSwitch User Guide*.

1. Select the **Line Hunt Groups** page.
2. Select a hunt group.
3. If necessary, select **Activate Hunt Group**. All hunt groups are active by default.
4. Enter a Hunt Group name. The default name is Hunt Group.

5. Set Line type to multi-branch VoIP or SPn VoIP Service.

6. Select the overflow hunt group. Choices are no overflow and the other activated hunt groups. If you select an overflow hunt group, ensure it contains different lines than the original hunt group.

**ADVANCED VOIP CONFIGURATION**

Optionally, perform advanced VoIP configuration.

**Setting up caller ID**

The VoIP Caller ID area allows you to set up the source for caller ID for outbound VoIP calls. The same setting is used for the multi-branch profile and all service provider profiles. Extension names are used by default.

1. Select the **VoIP Configuration** page.

2. Set the caller ID for outbound VoIP calls.
   - To use the *System name* from the **Administration** page, select *Use System Name in caller ID information for all outgoing VoIP calls*.
   - To use the *First name* and *Last name* from the **Local Extension/Fax** page set up for each extension, select *Use Extension Names in caller ID information for all outgoing VoIP calls*.
Reserving VoIP lines

By default, all VoIP lines are available for external IP extensions, multi-branch VoIP network calls, and/or service provider calls on a first-come first-served basis. You can also reserve VoIP lines for a specific use. For example, you can set aside two lines for external IP extensions.

Reserving VoIP lines guarantees resources for a specific network. Sharing VoIP lines uses them most efficiently.

1. Select the **VoIP Configuration** page.

2. Click **Reserve VoIP Lines**. The **VoIP Resource Reservation** window appears.

![VoIP Resource Reservation window](image)

3. Select the number of VoIP lines to set aside for each service. Choices range from 1 to the number of unreserved VoIP lines at this location. *Shared* means no VoIP lines are reserved for this service. Only unreserved lines will be available.

4. To transfer settings from your computer to the system, choose **File > Save**. A window appears indicating the configuration is being sent.
VERIFYING REGISTRATION

Clicking the View All Registrations button shows a window with a list of VoIP numbers, their registration status, and the number of seconds until their registrations with the SIP server will expire. This confirms that the system is registered with a SIP server.

1. Select the VoIP Configuration page.

2. Click View All Registrations. The Registration status window appears.

3. Choose All Registered Numbers or an active profile.
APPENDIX A — MULTI-BRANCH VOIP NETWORK ADMINISTRATION FORM

Use this form to keep track of VoIP numbers assigned to locations within a multi-branch VoIP network.

Location of the SIP server:_____________________________________________________________

Equipment at the SIP server location:____________________________________________________

VoIP numbers assigned to the SIP server location:__________________________________________

<table>
<thead>
<tr>
<th>Location name</th>
<th>Equipment</th>
<th>VoIP numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>